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Option Chains Panel

TheOption Chains panel in the Options tab is where you view the available options/spreads to trade. To access this window, click
the Options tab in OptionStation Pro.

Placing a Trade

There aremany ways to place a trade from theOption Chains panel:

l To buy a Call or Put, click the Ask price at your intended Strike.
l To sell a Call or Put, click the Bid price at your intended Strike.
l Right-click on the Bid or Ask column and select Buy or Sell.
l Select Trade from the Click to drop-downmenu, hold down the Ctrl key, and click next to your intended Strike to build a
spread with up to four legs. For more information, see Advanced Spread Building.

l To roll a position, click the Position quantity, and drag and drop it to the Position column at your intended Strike. You can roll
a position within one expiration term and across expiration terms.

l To close a position, click the Position quantity to open the Trade Bar.
l Right-click the Position quantity and select Close Position or Roll Position from the shortcut menu.

The Trade Bar will open with your order automatically populated and ready to trade.

Using the Option Chains Panel

TheOption Chains Panel contains the following features that refer to refer to the symbol selected in the Asset panel:

Spread Type

The Spread type drop-down list is used to select a single option or spread type for the symbol selected in the Asset panel.
The option chain displayed will change the Strike price column and related Calls and Puts values to reflect the specified type.

Filter

The Filter drop-down list is used to adjust the following settings:



l Strike Range: Determines the number of strikes displayed for a given expiration. The values on the left and right specify the
number of strike prices below and above the current price of the underlying asset. Use the slider or text box to change each
number. The letters ATM (At-The-Money) with a triangle beneath it point to where the strike price is the same as the under-
lying asset price.

l Num. Expirations: Determines the number of expiration dates to display (the default is ALL).
l Expiration Types: Determines the types of expirations to display. Select Monthlys, Weeklys, and/or Quarterlys.
l Deliverables: Determines the type of options symbols to display. Select Regular, Non-Standard, and/or Mini (1/10 of a stand-
ard sized option).

l Spread Width: Determines the distance between strikes in a spread.

Click Reset to reset to the default settings or Apply to apply the filter.

Strikes

The Strikes box enables you to adjust the strike interval though a drop-down list or by entering a specific amount. The option
chain displayed will change the spread construction, and the bid and ask prices will automatically recalculate.

Click to

The Click to drop-downmenu enables you to rapidly open, close, and roll trades.

1. Select Trade from the drop-downmenu to place an order, or Analyze Trade to send your spread to the Analysis tab.
2. Select Trade, hold down the Ctrl key, and click next to your intended Strike to build a spread with up to four legs. For more

information, see Advanced Spread Building.
3. If you selected Trade, depending on your preferences, the order will be sent with or without an order confirmation.

To enable/disable order confirms, from the TradeStationMenu bar, use the File > Preferences > Order Entry
menu sequence and select Options > Validations & Confirms.

If you selected Analyze Trade, the spread will appear in the Analysis tab.

Configure

The Configure button is used to customize the panel. SeeOption Chains Columns, below.

Strike

The Strike column shows the strike price of each option leg. The option chain can show up to four strike prices. See
Advanced Spread Building for more information.

Expirations

From left to right, the Expiration title row for each spread shows the:

l Expiration date: The date the option expires.
l Number of days left to expiration: the number of days the option is available for trading prior to expiration.
l Term: Monthly terms are not labeled. Weekly, Quarterly, and End of Month (EOM) terms are labeled and highlighted to
emphasize lower liquidity. SeeOption Term in the glossary.

l Average implied volatility: the average of the option's implied volatility within the specified term.
l Expectedmove: the price change (in dollars and cents) that the underlyingmay experience during the time period prior to the
option expiration date.



Calls

The columns listed under CALLS show the Bid and the Ask prices for Call options along with other option values such as
Volatility, Greeks, or Positions.

Puts

The columns listed under PUTS show the Bid and the Ask prices for put options along with other option values such as Volat-
ility, Greeks, or Positions.

Options, Analysis, Manage & Search tabs

TheOptions tab (pictured) is displayed by default. Click the Analysis, Manage, or Search tab to customize your trades.

Trade Bar

After you click Buy or Sell, the OptionStation Pro Trade Bar will open. Your order will be automatically populated and ready to
trade. The Trade Bar evaluates your positions when it opens and automatically sets the Open/Close actions for each spread
leg. The settings are alsomanually adjustable.

Option Chains Columns

The columns in the Option Chains panel can be added, removed, sorted, repositioned, copied to your clipboard, and exported to
Microsoft Excel.

Default columns (in order of appearance)

l Position – The number of contracts (+ for long and - for short).
l Open Int – The total number of open option positions for the specific option contract.
l Delta – The Delta option sensitivity of the option. For more information, see the Glossary.
l Bid – The current bid price of the call or put option.
l Ask – The current offer or sale price of the call or put option.
l Strike – The option chain can show up to four strike prices.

Other available columns (in alphabetical order)

l Ask Size – The number of contracts being offered for sale for each strike shown.
l Bid Size – The number of shares being offered for purchase for each strike shown.
l Close – The closing option price from regular trading hours.
l Exp – The expiration date of the option.
l Extrinsic – The time value portion of the options price.
l Gamma – TheGamma option sensitivity of the option. For more information, see the Glossary.
l High – The high price of the asset for the day.
l Imp Volatility – The volatility that is implied by the price of the option.
l Intrinsic – For calls: the intrinsic is max[underlying price - call strike price, 0]. For puts: max[put strike price - underlying price,
0]. For more information, see the Glossary.

l IV Skew Vol – The IV Skew Approximation volatility values.
l Last – The last traded price of the option.
l Low – The low price of the option for the day.
l Mid – Themid price is the average of the bid and ask prices.
l Net %Chg – The net change in percent since the last daily close.
l Net Chg – The net change of the asset since the last daily close.



l Open – The opening option price from regular trading hours.
l Prev Close – The closing price from the previous regular trading session.
l Prev Volume – The number of shares traded from the previous regular trading session.
l Prob BE – The probability of breaking even at expiration.
l Prob ITM – The probability of expiring in-the-money for each single option.
l Prob OTM – The probability of expiring out-of-the-money for each single option.
l Rho – The Rho option sensitivity of the option. For more information, see the Glossary.
l Symbol – The symbol for each option.
l Theo Value – The theoretical value displays the theoretical option price calculated using the PricingModel selected in Set-
tings.

l Theta – The Theta option sensitivity of the option. For more information, see the Glossary.
l Vega – The Vega option sensitivity of the option. For more information, see the Glossary.
l Volume – The number of shares traded so far in the current day. The Asset Panel displays shares; the Option Chains panel
displays contracts.

Related Topics

Asset Panel

Entering a Spread

Simulated Positions



Positions Panel

The Positions panel in theManage tab lets you build spreads and view your current positions as a portfolio. When new single legs
arrive in the Positions panel, each is placed in a separate single spread. You can combine leg positions into named spreads.

Positions Panel Layout

The Positions Panel is where your current positions are listed. You can right-click anywhere on the desired position row, and select
Load Underlying Option Chain from the shortcut menu to load the symbol into the symbol box and Asset panel, along with the
associated option chain.

Subtotals are listed at the bottom of the panel, whether they are weighted or not.

You can re-combine legs into positions using OptionStation Pro's SpreadMaster feature. For example, you can create named
spreads from existing legs tomake it easier to keep track of your positions and close or roll them with a single order. You can also
drop a position into an existing position so you don't have to drag individual option legs to combine positions.

The panel contains the following features:

Positions

These features are used tomanage your positions:

Beta Weighting

Select the BetaWeighting checkbox and enter a symbol name (or description) in the Symbol box. This allows you to view
your portfolio as if it was the equivalent of that symbol, by modifying the value in the Delta column of each position to approx-
imate the number of shares of that symbol. For example, if you beta weight your portfolio against the SPY and your deltas
total 500, your portfolio approximates the equivalent to that of 500 shares of the SPY. This enables you to see your long/short
delta exposure based on a single symbol, andmay be useful to determine position adjustments and hedging.

Configure

Click the on the upper right of the Positions panel to select configuration settings.

l Customize Columns - Opens the Customize Columns dialog that lets you add or remove columns and



change the column order.
l Best Fit (All Columns) - Automatically adjusts the width of columns that are displayed for the selected panel.
l Copy All Rows - Copies all rows to the clipboard.
l Export to Excel - Exports your position data toMicrosoft Excel.

Spread Rows and Columns

l - Expands the position to display the spread or expands the spread to display the legs in the spread position.
l - Collapses the position or collapses the spread to hide the legs in the spread position.

Following is a list of available Positions columns:

Default columns (in order of appearance)

l Underlying - The symbol of the underlying asset. Group subtotals are displayed in the underlying group row.
l Spread - The type of spread (Single, Vertical, Butterfly, Collar, etc.). If you are trading shares of options, in
addition to the spread type, the quantity, expiration term, strikes, and option type (put or call) may display in the
summary row. If you are trading shares of equities, Equity may display followed by the quantity.

l Days - The number of days to expiration an option has left. Blanks are displayed for equity positions. You can
sort positions from earliest to latest or from latest to earliest.

l Underlying Last - The real-time underlying last price.
l Account - The TradeStation account number for each position.
l Delta - The total Deltas of a position (single spread Delta * number of spreads in position * number of shares per
contract).

l Open P/L - The estimated profit or loss (P/L) of closing the position.
l Trade Cost - The position's aggregate trade cost.

Other available columns (in alphabetical order)

l Ask - The current ask (offer or sale price) of the call or put option for the spread.
l Bid - The current bid price of the call or put option for the spread.
l Est Closing Cost - The estimated cost of closing the position.
l Est Closing Price - The estimated price of closing the position.
l Expiration - The expiration date of the position. If the position contains options with different expiration dates,
the earliest date is displayed.

l Gamma - The total Gammas of a position (single spreadGamma * number of spreads in position * number of
shares per contract).

l ITM - Displays ITM when at least one option within an underlying group is In-The-Money (ITM).
l Max Loss - Themaximum potential loss of the position.
l Max Profit - Themaximum potential gain of the position.
l Mid - Themid price is the average of the bid and ask prices.
l Mkt Value - The current market value of the spread position. For options: (spread price * number of spreads in
position * number of shares per contract). For equities: (stock price * number of shares).

l Notes - The custom note you define.
l Open P/L % - The estimated closing P/L in percentage format. N/A is displayed if the trade cost is zero, which
avoids a divide by zero condition.

l Price - The current market price/premium of the position.
l Reward/Risk Ratio - The ratio of themax reward divided by themax risk.
l Risk/Reward Ratio - The ratio of themax risk divided by themax reward.
l Theta - The total Thetas of a position (single spread Theta * number of spreads in position * number of shares
per contract).



l Trade Price - The aggregate trade price for the position (on a per spread basis).
l Vega - The total Vega of a position (single spread Vega * number of spreads in position * number of shares per
contract).

l Volatility - The value of the volatility calculation being used as the source to the options pricingmodel.
l Volatility Mode - The type of the volatility calculation being used as the source to the options pricingmodel.

Position Controls

Click the on the right side of each spread column headers for the position controls:

l Reset All Positions - Collapses all positions and legs in the Positions panel, and reduces multi-leg positions to single pos-
itions for recombination at a later time.

l Lock All Positions - Places a lock icon to the left of all position rows indicating that the positions and their legs are locked and
cannot be accidentally added to or removed without first unlocking.

l Unlock All Positions - Removes the lock from all position rows allowing them to be added, removed, or modified.
l Remove Expired Legs - Removes any legs that have reached their expiration date.
l Remove Flat Legs - Removes any flat legs.

Spread Controls

Click the on the right side of each spread row for the spread controls:

l Close this Position - Opens the Trade Bar with an order to close the specified position.
l Roll this Position - Opens the Trade Bar containing an order to roll the entire position.
l Analyze Close or Analyze Duplicate - Adds the selected spread to the 2d or 3d graph for analysis.
l Create Empty Position - Creates an empty Custom position that can be populated with legs from another position.
l Merge Common Legs - Individual common legs within the position (i.e., those that represent the same side, type, price, and
expiration) will have their quantities added together into a single leg.

l Lock Position - Places a lock icon to the left of the position leg indicating that it is locked and cannot be accidentally added to
or removed without first unlocking.

l Load Underlying Option Chain - Loads the row symbol into the symbol box and Asset panel along with the associated
option chain.

l Copy Symbol - Copies the row symbol to the clipboard.

Legs

These features are used tomanage legs in a spread:

Leg Rows and Columns

Beneath the position spread headings are the legs that make up your option holdings for the current underlying symbol.

To show or hide leg column headers:

Right-click on a leg row and select Show ColumnHeaders from the shortcut menu.

Leg columns include the following values from left to right:

l Side – Shows the side (long or short) of each leg.
l Qty - Shows the number of contracts in each leg.
l Expiration - Shows the expiration term of each leg.
l Strike - Shows the strike price of each position leg. For equity positions, this column is blank.
l Type - Indicates whether the options in the leg are Calls or Puts.



l Symbol - The symbol for each position leg. Refer to OSI Symbology in the glossary for full symbol definitions.
l Underlying Asset - The symbol; for example, SPY. Note that a 7 at the end of the asset indicates amini
option.

l Expiration Date - The date format is YYMMDD; for example, 200701 is July 1, 2020.
l Option Type - Displays C for call or P for put.
l Strike Price - The price points of the underlying asset that are usually incremented by 0.5, 1, 2.5, 5, or
10 points.

l ITM Amount - Shows how much, in points, an In-The-Money option is In-The-Money. This is also referred to as
an option’s intrinsic value.

l ITM% - Shows an option’s In-The-Money amount in percentage format.
l Exercise Value - Shows the exercise value of each option leg.
l SPC - Shares Per Contract (SPC) displays the contract specific deliverable. Most equity options have 100
shares per contract, but different types of contracts such as mini options, or contracts that have been affected
by corporate actions, may have a different size.

Leg Controls

Click the on the right side of each leg row for the leg controls:

l Split - This will split a leg with a quantity of two of more into two separate legs. Adjust each spread inde-
pendently to any quantity that sums to the original leg quantity.

l Close Leg - This will send your closing order for the leg to the Trade Bar. From theOptionStation Pro Trade
Bar, select your order criteria. The Confirmation dialog displays with the order details of your closing trade.

l Roll Leg -This will send your rolling order for the leg to the Trade Bar.

Related Topics

Creating a Named Spread

Customizing Columns

Trade Bar



SpreadMaster

In OptionStation Pro, SpreadMaster refers to the ability to reconstruct two or more filled option legs into named spreads so that you
canmanage your current positions. You can view selected positions in the 2D and 3D analyzer to display a fully customizable risk
graph of your current position legs and can combine them with simulated positions allowing you to evaluate the potential of a mod-
ified or expanded position.

Why SpreadMaster

When simulated positions are filled in themarket they are stripped of their position name (identity) and single legs are returned to
the Positions panel. Positions sent for analysis in the Positions and Simulations panel may also be displayed as single legs. You,
the options trader, can either manually track the individual legs and see how each combination relates to the original simulated pos-
ition it was based on, or use the SpreadMaster feature to quickly create new spreads. SpreadMaster gives you the ability to com-
bine single leg positions into named position spreads, making it easier to manage your portfolio in both theManage and Analysis
tabs. You can adjust your spreads and legs from either location and the changes will be reflected in both places simultaneously.

Overview of SpreadMaster Features

l Automatic naming of spreads using Standard Spread Recognition Logic (SSRL)
l The ability to close all legs in a position spread with a single spread order (with four or less legs)
l The ability to split an option leg into two separate legs and independently adjust the quantity of each leg
l The ability to merge spread legs that are identical, except leg quantity
l The ability to monitor all of your current positions across all of your accounts all of the time
l The ability to drop a spread into an existing spread and break it back down into singles

Combining single leg positions into a spread position

You can quickly combine the legs of your spread by dragging each single leg position into another position until you've created the
desired spread.

1. Click and drag the first Single leg position.
2. Drop (release themouse button) the first leg over the second (another Single leg in this case).
3. The legs are automatically combined into a new spread position. For each leg added, the spread will automatically be

renamed as determined by the combination of leg sides, prices, and expirations.
4. Repeat 1-3 as many times as needed to create the desired spread position, with up to four legs.



Creating a new position

You can also create a new position by clicking the to the right of a position row (such as Single) and selecting Create Empty
Position. A new position namedCustom will appear in the panel. Simply drag legs into it in much the sameway as described
above to create a spread position.

For each leg added, the spread will automatically be renamed as determined by the combination of leg sides, prices, and expir-
ations. For example, the name of the Custom spread will change to Single when the first option leg is added.

Sending an order to Close a position

1. Click the button to the right of a position row.
2. Select Close this Position from the pop-upmenu.
3. The Trade Bar will open with the position information displayed.
4. From the Trade Bar, click the Place Order button.
5. Review the order shown in the Confirm dialog. When you are ready, click Yes to send the order to themarket.

Rolling a position

1. Click the button for the desired position, then select Roll this Position.
2. The Trade Bar will appear with your order to roll the entire position. Your order will be automatically populated and ready to

trade.

Splitting legs within a position

l Use the button on the right side of each leg row to split the leg into additional legs, send an order to close the leg, or roll the
leg.



Manage Tab

TheManage Tab is where your live trades are listed for your entire portfolio of positions. You canmanage your open orders and use
cancel/replace for price discovery in the Today's Orders panel. You can view your current positions as a portfolio in the Positions
panel. You can also use the Positions panel to build spreads using the SpreadMaster feature.

Manage Tab Layout

The tab contains the following features:

Today's Orders panel

Today's Orders panel lets you view the status of open and filled orders, and use cancel/replace for price discovery.

Positions panel

The Positions panel lets you build spreads and view your current positions as a portfolio. When new single legs arrive in the
Positions panel, each is placed in a separate single spread. You can combine leg positions into named spreads using
SpreadMaster.

Options, Analysis, Manage & Search tabs

TheManage tab is displayed here. Click the Options, Analysis, or Search tab to customize your trades.



Trade Bar

After you click Buy or Sell, the OptionStation Pro Trade Bar will open. Your order will be automatically populated and ready to
trade.

Related Topics

Today's Orders

Positions Panel

SpreadMaster

Trade Bar



Search Results Panel

The Search Results panel is where you search for options to trade. You are able to define your own search criteria, perform a
search, and compare the resulting spread candidates to find options that you believe are suitable for trading. To access this win-
dow, click the Search tab in OptionStation Pro.

Search tab

Click the Search tab; the Search panel appears.

Configuration

View and edit your search criteria for finding relevant option spreads for a specific asset. See below for more details on the dif-
ferent sections.

Run Search

Once all of the configuration criteria are specified, click Run Search to provide search results.

Results Grid

View the search results.

Search Configuration Sections

Current Settings Section

The underlying asset, volatility, pricingmodel, and proximity settings for your search.

l Asset - The symbol of the underlying asset that the search will be based on.
l Asset Volatility - The asset volatility setting that the search will be based on.
l Model - The PricingModel that has been defined in the Common section of the Settings dialog.
l Strike Proximity - The Strike Proximity setting that the search will be based on.
l Expiration Proximity - The Expiration Proximity setting that the search will be based on.

Strategy Section

Lets you identify the type of market outlook or individual spread strategy to base your search on.



l Strategy - Allows you to select aMarket Outlook Category or a specific Option Strategy from a drop-down list. Market
Outlook Categories are listed above the dividing line andOption Strategies below the line.

o A Market Outlook Category represents a group of spreads that all potentially profit from the samemarket movement.
Categories are organized by market outlook (Bullish, Bearish, ActiveMarket, Quiet Market) and risk profile (Limited or
Unlimited). Once a category is selected, the included spreads are displayed beneath the combo box.

o AnOption Strategy represents a specific spread type (Single, Vertical, Butterfly, Collar, etc.).
l Strike Interval - Allows you to select a strike interval for any strategy.
l Exp Interval - Allows you to select an expiration interval for selected strategies.

Market Outlook Section

Parameters used to define the price, expiration, and volatility conditions for your search.

l Projected Asset Price - Used to enter the percentage you believe the asset will move by the trade closing date. The text to
the right of the box shows the resulting asset price based on the value you enter. A positive percentage indicates a "bullish"
sentiment, a negative percentage indicates a "bearish" sentiment, and zero (Default) indicates a "flat" sentiment.

l Trade Closing Date - Lets you choose the date the trade will be closed from the calendar control. The closing date you
select will be used to select viable option expiration dates and other calculations, such as the projected price. Only options
with expiration dates later than the trade closing date (default = 1 day) will be included in the search. The text to the right of the
box shows the number of days to the specified closing date.

l Asset Vol Change - Used to specify the percentage you believe the volatility will move. A positive percentage indicates
"higher," a negative percentage indicates "lower," and zero (Default) indicates "flat." The text to the right of the box shows the
projected direction and volatility value based the value you enter.

l Projected Price Range - The projected price range is defined as the lower (-3 std dev) and upper (+3 std dev) price range that
the underlying can experience given the selected asset volatility.

Filtering Section

Use this section to determine the types of options to include in your results.

l Include Call Strategies - Indicates that Call strategies are to be included in search results, when checked.
l Include Put Strategies - Indicates that Put strategies are to be included in search results, when checked.
l Include Buy Strategies - Indicates that Buy strategies are to be included in search results, when checked.
l Include Sell Strategies - Indicates that Sell strategies are to be included in search results, when checked.

Run Section

Sets the ranking criteria and result size to display when clicking the Run Search button.

l Rank Results By - Used to select the column that the search will be ranked by.
l Number of Results - Specifies the number of spread results to place in the search results grid.
l Run Search - Clicking the Run Search button clears the previous results and generates new results based on the specified
criteria. Search results are not automatically updated after being loaded.

Search Results Columns

Columns for the Search Results can be added, removed, sorted, and repositioned. For more information, see Customizing
Columns in OptionStation Pro.

Available columns for the Search Results include:



Fixed columns - ordered left to right

Strategy – The type of spread strategy.

Description – The type of spread (Single, Vertical, Butterfly, Collar, etc.). If you are trading shares of options, in addition to the
spread type, the quantity, expiration term, strikes, and option type (put or call) may display. If you are trading shares of equities,
Equity may display followed by the quantity.

Default columns - ordered left to right

Price – The current market price/premium of the position.

Max Loss – Themaximum potential loss of the position.

Max Profit – Themaximum potential gain for the position.

Profit/Loss Ratio – The ratio of themax profit divided by themax loss.

Projected Price – The price of the spread on the trade closing date after applying the user-supplied underlying price and asset volat-
ility change.

Projected Profit – The profit of the spread on the trade closing date after applying the user-supplied underlying price and asset
volatility change.

Probability of Profit –The probability that an option spread will be profitable by a fraction of a penny or more. It considers the prob-
ability of the underlyingmoving to asset prices that cause the spread to become profitable.1

Expected Value – The amount that the trader can expect to win or lose on average for each trade of the spread. The Expected
Value is evaluated over an underlying price range of +/- 3 standard deviations. Throughout this range, the spread value at each
underlying price is multiplied by the probability of the underlyingmoving to that price. Finally, all of the resulting products are added
together to arrive at the Expected Value. The Expected Valuemay also be described as theMathematical Expectation1.

1 The book TheMathematics of Options Trading by C.B. Reehl (ISBN 0-07-144528-5) was used as a reference for calculating
the probability related columns. A specific trading example can be found on pages 123 – 129.

Pos Delta – The total Deltas of a position (single spread Delta * number of spreads in position * number of shares per contract).

Pos Rho – The total Rho of a position (single spread Rho * number of spreads in position * number of shares per contract).

Pos Theta – The total Thetas of a position (single spread Theta * number of spreads in position * number shares per contract).

Pos Vega – The total Vega of a position (single spread Vega * number of spreads in position * number of shares per contract).

Pos Gamma – The total Gammas of a position (single spreadGamma * number of spreads in position * number shares per con-
tract).

Other available columns - listed alphabetically)

Pos Delta Close Date – The total Delta of the position on the trade closing date after applying the user-supplied underlying price
and asset volatility change.

Pos Gamma Close Date – The total Gamma of the position on the trade closing date after applying the user-supplied underlying
price and asset volatility change.

Pos Rho Close Date – The total Rho of the position on the trade closing date after applying the user-supplied underlying price and
asset volatility change.

Pos Theta Close Date – The total Theta of the position on the trade closing date after applying the user-supplied underlying price
and asset volatility change.



Pos Vega Close Date – The total Vega of the position on the trade closing date after applying the user-supplied underlying price
and asset volatility change.

Probability of Loss – The probability that an option spread will sustain a loss by a fraction of a penny or more. It considers the prob-
ability of the underlyingmoving to asset prices that cause the spread to sustain a loss. See note 1 above.

Qty – All spreads in the OptionStation Pro results grid are displayed on a one spread basis, therefore, the quantity is fixed at 1.
Click Analyze to copy the spread to the Analysis tab. Once the spread is in the Analysis tab, quantity changes, spread analysis,
and order placement can be performed.

Related Topics

Options tab

2D Graph

3D Graph
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